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1 Introduction 

This document guides the user through the required steps, within Control Techniques Connect 
software and Beckhoff’s TwinCAT IDE, to get a NC motion control axis working with a Control 
Techniques drive over EtherCAT.  

The steps required to get the axis working are as follows: 

 

 

The end result is a Control Techniques drive that can be used with the NC axis motion control 
function blocks included with TwinCAT. 

 

Start 

ESI File Installation 

Initial TwinCAT project setup 

Setup an EtherCAT AoE connection from the PLC to the drive 

Finish 

Configure the drive using Connect 

Commission the drive and motor using Connect 

TwinCAT Axis Configuration 

Moving the axis using TwinCAT test moves 

Using PLCopen to move an axis 

HINT: The information in this manual is backed up by training videos on YouTube.  
 

 Nidec Drives Support - YouTube 

HINT: The ESI file must match the firmware of the EtherCAT module. Section 10.5 How to 
upgrade EtherCAT Firmware. 

 

https://www.youtube.com/channel/UCoJ2Rr3XO88Lp-FQSLn8dbQ
https://www.youtube.com/channel/UCoJ2Rr3XO88Lp-FQSLn8dbQ
https://www.youtube.com/channel/UCoJ2Rr3XO88Lp-FQSLn8dbQ
https://www.youtube.com/channel/UCoJ2Rr3XO88Lp-FQSLn8dbQ


                           Page 5 of 153  

  

2 ESI File Installation 

1. Get the latest ESI files from the Control Techniques Section of the Nidec Drives website and 

extract the contents of the .zip file. 

  

2. Make sure that TwinCAT is not running. Close the program if it is. 

 

3. Extract the contents of the ESI file zip.  

 
Copy the contents of the zip to “C:\TwinCAT\3.1\Config\Io\EtherCAT” or for newer 

installations of TwinCAT “C:\Program Files (x86)\Beckhoff\TwinCAT\3.1\Config\Io\EtherCAT” 

 

4. When TwinCAT is next run, it will recognise Control Techniques drives after a “Scan”. 

 

 

 

 

 

 

 

 

HINT: The ESI file must match the firmware of the EtherCAT module. See section 10.5 
How to upgrade EtherCAT Firmware. 
 

HINT: If the ESI files don’t match the firmware in the EtherCAT option, after scanning the 

network and adding the EtherCAT master in the “I/O” section, the drives will appear as 

“Box 1”, “Box 2” etc. 

https://acim.nidec.com/drives/control-techniques/services/Drive-Setup
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3 Initial TwinCAT project setup 

To allow Connect to communicate to the slave drives in the EtherCAT network, an AoE (ADS over 
EtherCAT) connection must be configured.  

Before continuing, an Ethernet cable should be connected between the Ethernet port of the 
programming PC and the Ethernet port of the PLC / IPC / Controller (X000 in the diagram below).  

A second Ethernet cable should be connected between the EtherCAT port of the PLC / IPC / 
Controller (X001 in the diagram below) and the EtherCAT post of the Control Techniques Drive / SI-
EtherCAT module in use. 

It is assumed that the Ethernet addresses of the programming PC and PLC / IPC / Controller are in 
the same range e.g.192.168.1.x. 

X001
192.168.2.20

192.168.1.50

X000
192.168.1.207

EtherCAT Ethernet 

PC 

 

 

This section shows the first steps required to get connected to a Beckhoff PLC/IPC. 

1. Start TwinCAT. For the purposes of these examples the TwinCAT XAE Shell will be used 
to run the TwinCAT IDE. This is available even if the PC doesn’t have Visual Studio 
installed. 
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2. Select “New TwinCAT Project”: 

 
 
 

3. Give the project a sensible name e.g. “MotionProject” and then click “OK”. 
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4. Select the target PLC. If your PLC has previously been connected to a TwinCAT project, 
then the ADS Address of the PLC is shown. 

 
 
If the PLC hasn’t previously been connected to a TwinCAT project, then select “Choose 
Target System…” and then “Search (Ethernet)” from the “Choose Target System” dialog.  

 
 
 



                           Page 9 of 153  

  

5. When the “Add Route Dialog” starts, click “Broadcast search”. 

  
 
 and then select the adapter to search for compatible devices and click “OK”: 
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6. Select the PLC to connect to and then click “Add Route” and then “Close”. 

   
 

 
Click “Yes” if the message below appears: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

HINT: If there is an Administrator password challenge the default password is “1” 

 

HINT: For brand new IPCs it is likely that the runtime hasn’t been installed, and that the 
EtherCAT port hasn’t been assigned. See section 10.6 How to setup a Beckhoff IPC  
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If this doesn’t allow connection, Ping the IP address for the device or connect via Remote 
Desktop to ensure the connection to the PC is good. Then enter the IP address into the 
“Enter Host Name  / IP:” and press enter.
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7. An optional step is to clean up any unrequired items from the project tree e.g. this 
example doesn’t require Safety, C++, or Vision etc. To do this right click on the item and 
select “Hide xxxx”. 
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8. Expand “System” in the project tree, click on “Real-Time”: 

 
 
When the project settings tab appears, Select “Read from Target” to update the 
information on the number of processing cores. 

 
 

9. Make sure the TwinCAT is in Config Mode by clicking on  in the tool bar and then 
click “OK” when prompted with the “Restart TwinCAT system in Config Mode” message: 

 
 
Failure to do this may result in the “Scan” feature being greyed out. Click “Yes” to the 
“Activate Free Run” pop-up. 
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4 Setup an EtherCAT AoE connection from the PLC to the drive 

An EtherCAT AoE (ADS over EtherCAT) connection allows communications between the drive(s) and 
the Connect PC tool in systems where the only communications connection to the drives is EtherCAT.  

In the latest version of Connect it is possible to access the drive using the EtherCAT masters AMS 
network ID: 

 

1. Expand the “I/O” category in the project tree, and then right click on “Devices” and select 
“Scan”: 

   
  
 
 
 
 
 

2. Click OK on the message below: 

 
 

HINT: If “Scan” is greyed out, put TwinCAT in “Config” mode by pressing the following 

button .  
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3. Select the “(EtherCAT)” device and then click “OK”.  

 
 

4. Make sure the Control Techniques drive has a suitable Ethernet cable connecting the drives 
EtherCAT port to the PLC’s EtherCAT port. To use the PLCopen functionality the drive must 
be either a Unidrive M or a Digitax HD.  
 

5. Next, TwinCAT will prompt the user to scan the network for boxes. In this context, boxes 
means EtherCAT devices connected to the PLC’s EtherCAT port. Click “Yes” to accept this. 

 

 
6. When the axis is found the “EtherCAT drive(s) added” dialog is shown. This guide is for 

PLCopen which requires the “NC – Configuration”. Select this and then click “OK”. 

 
 

HINT: If there are any issues connecting to the target drives, the ESI files in TwinCAT 
may not match the firmware in the EtherCAT interface on the drive. The ESI file must 
match the firmware of the EtherCAT module. Section 10.5 How to upgrade EtherCAT 
Firmware for details on how to update the firmware.
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7. When the scan process is completed the PLC/IPC ADS Net ID, (used by Connect), may be 
located. Double click on the EtherCAT network Master in the Solution Explorer, e.g. “Device 
2”, and then select the “EtherCAT” tab. The AMS network ID is given next to “NetId:”. 

  

 
8. Click the “Activate Configuration” button and then click “OK” if the “Activate Configuration” 

dialog appears:  

  
 
Click “OK” on the “Restart TwinCAT in Run Mode” dialog:  

 

HINT: The EtherCAT port device number varies between different PLCs, depending on 
the network ports available. In general, the port required will be described as Device (n) 
(EtherCAT). 
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9. If the system is operating properly the status icon in the bottom right corner of TwinCAT will 
show a green box with a rotating cog: 

 
 

10. Communications will now be running and Connect will be able to search for the drive(s) on 
the EtherCAT network using the “NetId:” from step 7. 
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5 Configure the drive using Connect 

Create a new Connect project to configure and commission the drive for the motion application: 

1. Open the Connect PC software by double clicking the “Connect” icon. 
 

  

2. Ensure the version of Connect is a minimum V3.0.0. If an earlier version is installed please 
upgrade to V3.0.0; the software file may be obtained from your local Control Techniques 
Drive Centre / Distributor, or http://acim.nidec.com/drives/control-techniques, or Control 
Techniques Support Suite. 

 
 
 

3. When Connect opens select “New project from network scan”. 
 

 

4. Select the communications type, such as ADS, to scan that network and locate the drives to 
be configured:  
 

 

HINT: Section 4 Setup an EtherCAT AoE connection from the PLC to the drive 
shows where to get the EtherCAT AMS Net ID / ADS Network ID in TwinCAT. 

http://acim.nidec.com/drives/control-techniques
https://support.controltechniques.com/
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5. When the scan completes all of the available nodes on the network will be found.  
 

 

 

6. Give the project a meaningful name and then click “New project with selected drive”.  
 

 

HINT: For this to be successful on an EtherCAT-based network, the Beckhoff TwinCAT 
PLC/IPC must be running, as indicated by a green “TC” LED on the PLC/IPC and the 
activated symbol highlighted in TwinCAT.  
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7. When the project opens, all drives on the network will be “Online” as indicated by the blue 
highlight on the “Online” button, the green dot next to each drive node in the Explorer tree, 
and the green border around the active tab. 
 

 
This means that any changes made take direct effect in the drive. 
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8. The first drive in the Explorer list is selected and has it’s drive setup wizard opened. 
 

 
 
On this page the user can default the drive to remove any previous setup, change the 
operating mode to match the motor that has been connected to the drive, and select the 
region e.g. 50Hz or 60Hz.  

HINT: Has comms been lost after changing the drive mode? This might be because the 
EtherCAT interface has V1 firmware installed which as a part of the start-up checks 
includes the drive mode. V2 firmware removes this issue. If the drive mode is changed 
the comms connection stops completely, in TwinCAT, change to “Config mode”, delete 
the EtherCAT drive nodes, and then right click on the network master and select “Scan” to 
add the nodes in their new mode, and then activate the configuration. Alternatively, 
uncheck the “Check Product Code” and “Check Revision Number”, and then activate the 
configuration. See also section 10.5 How to upgrade EtherCAT Firmware.  
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The guided setup section is selected by either the “Next” and “Back” buttons, or by directly 
selecting a section by clicking on the circle section markers. 

 
 
When finished, click “Next” move to the motor and feedback setup.  
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9. Setup the motor and feedback device on the “Motor and Feedback” page. The required data for 
the motor and feedback device will be available on the motor name plate or the technical data 
sheet for the motor. 
 

 
 
The user must configure the motor, feedback device and thermistor setup here. 
 
For a permanent magnet motor, the user must set the Torque Per Amp field on the motor 
feedback step. If the value of Kt isn't provided on the rating plate, it approximated by dividing the 
Motor rated torque by the Motor rated current. For an induction motor, the drive calculates the Kt 
value from the motor data. This value is used by the motor and load inertia calculation step, which 
helps make the motor tuning simple with a single slider. 
 

Help is provided throughout Connect using small help trigger squares : 
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It is possible to save a motor and encoder configuration for later use; these are searchable too. 

 

 
For induction motors, where the thermistor is not typically connected to the encoder interface D 
Type, and instead, is connected to a terminal on the drive ( e.g. Analogue input 3). Set Analogue 
Input 3 Mode to Thermistor. 
 

 
 
If the drive is either a Digitax HD or a Unidrive M with firmware >=V01.61.01.00 and the motor is 
one from Control Techniques Dynamics that has an electronic nameplate loaded into the encoder, 
the motor and encoder data is setup automatically where the “Motor & Feedback” page looks like 
the example below:

 
 
The light blue highlight shows that the electronic nameplate has been loaded. In addition, for 
EnDat 2.2, EnDat 3.0 and BiSS-C encoders the “Encoder type” fields are also configured 
automatically.  

HINT: Control Techniques Dynamics permanent-magnet servo motors and Leroy Somer 
induction motors and permanent-magnet process motors may be found using the motor 
search: 
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When finished, click “Next” to move to the brake setup. 
 

10. The brake setup page allows braking resistor properties to be configured. The braking resistor 
is used to dissipate motor energy when slowing down. The settings provide protection for the 
braking resistor in addition to a thermal overload circuit which is typically provided with the 
resistor. 
 
It is also be used to set up the drives mechanical brake controller. The mechanical brake 
controller releases and applies the mechanical brake automatically, making sure that the load 
is always controlled by either the motor or the mechanical brake. It is typically used in hoisting 
applications. For the majority of applications, assigning the “Brake Control: Brake Release” 
Output, setting the time for the brake to physically release the load in “Brake Control: Post-
brake Release Delay”, and the time for the brake to physically apply and hold the load in 
“Brake Control: Brake Apply Delay” is sufficient.   
 

 
 
For more information on the mechanical brake controller logic and timings see section 11.1 
Mechanical brake controller logic. 
 
When finished, click “Next” to move to the reference setup. 
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11. The reference setup page for an EtherCAT motion control application, is where the maximum 
reference clamp is defined. Normally, the maximum reference clamp must be set to the motor 
rated speed, however, in some applications this is modified and may be adjusted from this 
page. 
 

 
 
When finished, click “Next” to move to the EtherCAT setup. 
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12. The EtherCAT Setup page allows the user to configure the stop behaviour from a digital input 
and from a loss of comms. 
 

 
 
When the “Easy Stop Mode” box is checked, the user can assign a digital input that will cause 
the axis to stop. The axis is permitted to run when 24V is applied to it, but if 24V is removed 
the axis will stop, using the “Easy Stop Deceleration Rate”.  
 
The “Easy Stop Deceleration Rate” is also used when there is a loss of EtherCAT 
communications. The “Controlled Stop Network Loss Threshold” is a weighted threshold that 
increases by 3 for every missed message and decreases by 1 for every received message. In 
this way, occasional missed messages don’t affect the system, but a more permanent loss of 
messages such as a broken EtherCAT comms cable will stop the axis. 
 
The “Zero speed threshold” is used by the CiA402 state machine, (the CANopen motion 
standard used to control the axis over EtherCAT communications), to verify that the axis has 
actually stopped before allowing further movement. The default value is suitable for most 
systems except those that have a noisy or low-resolution feedback device, in which case the 
value must be increased to account for the additional feedback noise. 
 
When finished, click “Next” to move to the Limits setup. 

13. The limits page allows the user to assign digital inputs to become hardware limit inputs. If the 
application doesn’t have hardware limits, leave the digital input assignments empty and move 
to the next step. 
 

 
 
When finished, click “Next” to move to the Save Parameters page. 
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14. The save parameters page allows the parameters configured so far to be saved. It is advised 
to do this prior to the commissioning activities since the power might have to be removed to 
correct a hardware issue as a result of a failed Autotune test, such as a reversed motor or 
encoder wiring. 

 
 
This completes the configuration section of the guided setup. The next section of the manual 
describes the commissioning of the drive and motor using the remaining steps in the guided 
setup. 
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6 Commission the drive and motor using Connect 

This section describes the process of commissioning the drive and motor in the application using the 
tools provided in the guided setup, which consist of:  

 
• Auto-tune to measure the electrical properties of the motor such as resistance and 

inductance. 

• An inertia-auto-tune to measure the inertia of the motor and load. Once this measurement is 
taken, tuning the axis is simplified to a single slider. It is strongly recommended to run this 
test. 

 
• Performance tuning and test moves. This page is a “one stop shop” with test move controls, 

motion profile setup, oscilloscope, and tuning controls on a single page ideal for site 
commissioning using a laptop. 

 

• Finalising the application by saving the tuned parameters and creating a startup list allowing 
the PLC / IPC to configure the drive, each time the system powers up; this is helpful if the 
drive must be replaced. 
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Use the following steps to commission the motor and drive in the application. 

1. Wire a switch or similar device to the drives STO input(s) where 24V is connected to the STO 
input(s) to enable the drive. The drive will not be able to run the motor until such a device is 
fitted. The terminals that supply 24V and host the STO input(s) are shown by the  
“Terminal Overview” in the device explorer. 
 

   
 

 

 
2. Before attempting to run the Auto-tune ensure the STO switch is open i.e. 24V is not 

connected to the STO terminal(s). 
 

SAFETY: Remove power from the drive before attempting to modify the drive or motor 
electrical connections. 
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3. The default setup for the auto-tune will be suitable for most applications. Additional controls 
are provided for expert users.  
 
Making sure the motor is safe to move, run the Auto-tune by pressing “Start Autotune” 

 
 
The tool will advise you to apply 24V to the STO terminal to run the test. 

 
 
The test takes approximately 30s to complete 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



                           Page 32 of 153  

  

When the test completes, the drive must be disabled by removing 24V from the STO input. 

 
 
The electrical property autotune is completed. Click next to move to the “Motor and load 
inertia” page. 
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4. The “Motor and load inertia” page configures a test to measure the motor and load inertia. 
This test is important as it allows the speed loop gains to be configured using a single control 
slider: 
 

                                     
 
If the motor has a load connected, the default settings will be OK for most systems. Where 
there is no load i.e. a bare motor shaft it is recommended to increase the “Mechanical Load 
Test Level” to 5%. If the test fails to identify the inertia, increase the mechanical load test in 
steps of 5% up until 20% is reached.  

 
 
Start the inertia test by clicking “Start Auto-tune”: 

 
 
The tool will advise you to close the STO switch to apply 24V to the STO terminal and run the 
test. 

 
 
When the test completes, remove 24V from the STO terminal. 
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The inertia test is complete. Click Next to move to the “Performance Tuning” page. 
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5. The “Performance Tuning” page provides a set of tools on a single page, optimised for laptop 
use, that are used to commission the drive and motor. The different sections of the tool are 
described below: 
 
Oscilloscope – to show what is happening to the motor speed while jogging or tuning takes 
place: 

 
 
Oscilloscope controls – start and stop the trace,  allow channels to be added / removed / 
modified, triggering, trace saving. 
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Test move commands – enable the test controls, jog forward / backwards, automatic running 
as a tuning reference. 

 
 
Commissioning tabs – configure the test move motion profile, speed and position loop tuning, 
application optimisation controls, and noise optimisation controls. 
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Status control – Shows key values, drive status, trip data and resetting. 
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6. Begin commissioning by jogging the axis (slowly) to determine if the motor direction is correct 
for the application. Ensure it is safe to move the motor. Click on “Take Drive Control” and then 
apply 24V to the STO input. 
 

 
  
Configure the motion profile settings used when the test moves are running. This includes the 
jog speed, automatic running speed, acceleration and deceleration times, S ramp percentage, 
the overall profile time, and whether the automatic running is in one direction, or bipolar where 
the motor reciprocates back and forth. 
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Select the Tuning tab, and then select “Bandwidth” mode. This will give moderate tuning 
suitable for many applications, with headroom to increase the gains further if required. 

 
 
Start the oscilloscope by pressing the Oscilloscope start/stop button. 

  
 
Jog the axis forward by pressing F4 or clicking on the Jog Forward button. 
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Verify that the movement is stable and that the forward direction of rotation is correct for the 
application. If the movement is unstable, modify the tuning slider until the desired 
performance is achieved. If the motor is turning the wrong way when jogging forward, remove 
24V from the STO Input, select the Application tab, and then set the “Change Motor Direction” 
control to “Reverse”. Re-apply 24V to the STO terminal and verify that the motor direction is 
now correct when jogging forward. 

 
 
 

7. If the application axis has hardware limit switches connected, test them by jogging into them 
gently and prove that the axis stops and that the switches have been connected to the correct 
terminals.   
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8. Verify the step response of the motor and load by enabling automatic running. Before tuning 
using these commands make sure that if the axis has physical limits that it is placed in the 
centre of these limits and that Bipolar mode is selected so that the axis moves back and forth. 
To stop the axis press F5 or click the stop button: 

  
 
Select the initial direction of travel when automatic running using F2 (backwards) or F3 
(Forwards) or by clicking the Run Forwards, Run Backwards buttons: 

 
 
It is recommended to start with a slow Run speed and then gradually increase to make sure 
the axis doesn’t move too far on the first try. The speed can be increased while running but 
bear in mind that the higher the speed, the further the axis will travel. 
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9. Once the correct automatic run profile is running, the axis may be tuned further. Observe 

Final Speed Reference Pr3.001 and Speed Feedback Pr3.002 overlaid with each other, and 

the Speed Following Error Pr3.003 on a separate trace. Ensure there is no significant 

overshoot when stopping or when reaching the speed reference. If there is overshoot the 

gains can be increased. When doing this check that the drive isn’t going into current limit by 

observing Pr10.009; this may be placed on the same trace as the speed following error.  

The example shows what the axis performance might look like prior to tuning: 

 
In the previous example trace it can be seen that there is significant speed overshoot caused 

by the load inertia and default gains. The speed following error shows oscillations when 

accelerating and decelerating. All of these artifacts can be tuned out easily using “Bandwidth” 

mode and adjusting the slider control to achieve the desired performance. 

 

The example below shows an optimised result for the same application where Bandwidth 

mode tuning has been used to optimise the performance: 

 
From the previous trace it can be seen that there is no significant speed overshoot, the speed 

following error isn’t oscillating, and the drive isn’t going into current limit.  
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If the drive is observed going into current limit, (Current Limit Active trace goes to 1), it is an 

indication that the drive is going into constant torque due to hitting the current limit. This can 

be resolved by increasing the current limits on the Application tab or by decreasing the 

acceleration and deceleration rate. It is further recommended to verify that the drive and 

motor combination have been sized correctly for the application in terms of their torque and 

current capability. 

 
 

10. If the motor is sounds noisy with the tuned values select the  “Motor Noise” tab: 

 
 
For most applications it is recommended to use a Current Loop Filter Time Constant of 
1.0ms, unless the application is ultra-dynamic and needs a very fast response where a lower 
value is needed. A 1.0ms filter gives a 159Hz response bandwidth, where most systems will 
be well tuned at between 50Hz and 100Hz. 

 
This helps in the following situations:  

o The speed reference or speed feedback contains a noise component e.g. if the 
feedback device is of low resolution. 

o If the speed loop gains have been raised to the point where the motor noise has 
become unacceptable, and the required speed loop performance hasn’t been 
reached. 

o The application often runs with a low motor speed where encoder quantisation noise 
is an issue. 

o There is mechanical resonance affecting the feedback. 
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The filter frequency bandwidth with time is 1.0ms = 159Hz, 0.9ms = 177Hz, 0.8ms = 199Hz, 
0.7ms = 227Hz, 0.6ms = 265Hz, 0.5ms = 318Hz, 0.4ms = 398Hz, 0.3ms = 530Hz, 0.2Hz = 
795Hz, 0.1ms = 1592Hz. 

Provided the drive and motor is rated for a higher switching frequency, increasing the 
switching frequency can reduce audible noise from the motor.  

 
 
If the motor has a continuing 1kHz tone after the adjusting the switching frequency and the 
current loop filter, the noise can be improved by making a small reduction in the Current loop 
P Gain with “Maintain Gain Ratio” selected to keep the balance between the current loop P 
and I gains. 

    
 

11. This stage of the tuning is complete. Further tuning may be required later to fully optimise the 
speed loop and position loop when the TwinCAT program provides the motion reference to 
the drive over EtherCAT PDO. Disable the drive by removing 24V from the STO input, and 
then disable the test move control by clicking on the “Release Drive Control”. When drive 
control has been released it looks as shown below: 

 
 
Click Next to move to the “Finalise” page. 
 

12. Save the tuned parameters in the drive by clicking the “Save Parameters” button: 
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13. An EtherCAT startup list may be generated to preserve the configuration in the TwinCAT 
PLC/IPC. The startup list is in the form of an startup list.xml file that may be imported into 
TwinCAT.  
 
It is recommended to perform this after the application software has been written and 
the position loop has been tuned.  
 

 

 
StartupList.xml is stored in the following location: 
C:\Users\[USER NAME]\Documents\Control Techniques\Connect Cobalt\[PROJECT 
NAME]\devices\[DEVICE NAME]\StartupLists.  
 
See section 10.8 How to use a startup list in TwinCAT for more information    
 

14. The startup list for an EtherCAT device is a helpful way to configure CiA402 CAN objects and 
drive parameters (addressed as CAN objects) when an EtherCAT node starts. There are a 
few standard ways in which this feature is used: 

 
o To configure CiA402 CAN objects that define how the system operates such as the 

behaviour of the drive when comms are lost via object 0x3005. 
 

o To apply the parameters used to setup a drive axis from scratch. This will restore the 
original drive configuration in case the drive parameters have been altered.  

 
o It can also be used to automatically configure a brand new drive (assuming the drive 

and EtherCAT option firmware match) in the event that a drive is replaced. 
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15. It is advised to make a parameter file once tuning has been completed by selecting “Files” > 
“Parameter Files” > “New parameter file…”. This file preserves the final setup of the drive, 
regardless of what happens to the Connect project later on, and forms a useful future 
reference of the configuration. Click “Save” to create the parameter file. The file is 
automatically time and date stamped, e.g. Unidrive M700-(2025-03-18 0856).parfile was 
created at 8:56 on 18/3/2025. 

 
 
 



                           Page 47 of 153  

  

7 TwinCAT Axis Configuration 

This section describes how to setup the basic properties of an axis including its unit scaling and 
monitoring. A detailed description of how scaling works is given in section 10.4 How to setup axis 
unit scaling. 

1. Put the IPC  /PLC into configure mode by pressing the config mode button.  

 
 

2. Set up the axis scaling. This can be found by selecting “MOTION” > “NC-Task 1 SAF” > 
“Axes” > “Axis 1” and then double click on “Enc”:  
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3. The Encoder setup appears. Select the “Parameter” tab. “Scaling Factor Numerator” defines 
the number of Units represented by the number of encoder counts defined by “Scaling Factor 
Denominator”. See section 10.4 How to setup axis unit scaling for more information on how 
to scale the NC axis units. 

 
In the example above for 360° there are 65536 counts, so for 1 revolution in encoder counts 
we have 360°. Other configuration for things like software limits and DS402 Homing are on 
this tab if needed. The modulo factor only needs to be set if the axis is going to do some 
modulo positioning using MC_MoveModulo. 
 

4. Next choose the units that the axis uses. Select “Motion” > “NC-Task 1 SAF” > “Axes” and 
then double click on “Axis 1”:  
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5. The axis setup appears. Select the “Settings” tab, and then change the unit type to something 
suitable e.g. “Degree”.  

 
 

6. Turn off the encoder following error limits as these tend to cause nuisanse NC axis errors the 
first time the axis runs. Double click on the axis in the “Solution Explorer” tree, then select the 
“Parameter” tab. Scroll down to “Monitoring” and set “Position Lag Monitoring”, “Position 
Range Monitoring”, and “Target Position Monitoring” to FALSE. These checks can be 
reinstated later if required. 
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7. Set the maximum dynamics. Typically the “Reference Velocity” and “Maximum Velocity” need 
to be set to the maximum reference that can be applied to the motor, as shown by Maximum 
Reference Clamp Pr1.006 or as configured on the “References” page in the Connect guided 
setup: 

 
 
Use the formula provided in section 10.4 How to setup axis unit scaling to convert the 
maximum reference speed in rpm into units/s. An example is given below: 
 
     An axis has a maximum speed of 3000rpm, and a scaling numerator of 360 units per  
     revolution, the maximum speed in units per second is 3000 * 360 / 60 = 18000. 
 
Unless the application has a specific reason to limit the acceleration and deceleration 
maximum, the best option is to set the acceleration and deceleration to a high value such as 
1E+20, (100000000000000000000), so they don’t cause nuisance NC axis errors when the 
axis is run for the first time. 
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8. Configure the default dynamics for the axis. These are entirely dependent on the specific 
application. It can be helpful to set the default Jerk to 1E+20, (100000000000000000000), 
which will invoke a linear acceleration profile if the jerk is left at 0 and will prevent nuisance 
NC axis errors.  
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8 Moving the axis using TwinCAT test moves 

1. Click on the “Online” tab to reveal the test controls. At this point the system will be offline in 
Config mode so the controls are greyed out. 

 
2. Click the “Activate Configuration” button and then click “OK” if the “Activate Configuration” 

dialog appears:  

  
 

3. Click “OK” on the “Restart TwinCAT in Run Mode” dialog:  
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4. The “Online” tab test controls are now available. To run the drive the “Enabling” control must 
be configured. Press the “Set” button and when the “Set Enabling” dialog appears press the 
“All” button and set the override percentage to 100%. The axis will now move if for example 
F2 or F3 are pressed to jog the axis.  

 

 
  
 
 

  

HINT: The motion profile setup is configured on the “Parameter” tab under “Manual 

Motion 
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5. The on screen buttons have the following function: 
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9 Using PLCopen to move an axis 

This section describes the basic steps needed to get PLCopen functionality running on a Beckhoff 
PLC. It is assumed that all the previous steps have been followed and the axis is proven to be 
working using the test moves control. 

1. Before adding the motion it is worth reviewing the task and PDO update rates to see if they 
are suitable for the application. By default, the tasks are set to 10ms update which is relatively 
slow. Ideally, the PDO update, the NC Axis update rate and the PLC task should update at 
the same time e.g. all 1ms. 
 
Set the Base time for real time tasks to 1ms: 

 
 
Set NC-Task 1 SAF to 1ms: 
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Set NC-Task 1SVB to 1ms: 

 
 
Set the task that the motion code is executed to 1ms: 
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2. We need to add the basic motion libraries required for point to point (PTP) motion. Select 
“PLC” > “[project name]” > “ [project name] Project” > “References” then right click “Add 
Library...”  
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3. Select “Motion” > “PTP” and then highlight “Tc2_MC2” and then click “OK”:  

 
Repeat this process for the other libraries in the “PTP” category. 
 

4. Select “PLC” > “{project name}” > “ {project name} Project” > “POUs”  and then double click 
on “MAIN”.  

 
 

5. In the PLC part of the project add an AXIS_REF. This is the PLCopen axis interface and is 
referred to in Beckhoff terminology as the “PLC Axis”. Add the following into the declaration 
area of the MAIN POU.  

 
It is best to keep the naming of the axis similar to the project axis. 
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6. Build the project so the new AXIS_REF is known to the Project. Select “Build” > “Build 
Solution” or press Ctrl+Shift+B.  

 

 
7. Link the PLC Axis to the Motion Axis. Select “Motion” > “NC-Task SAF” > “Axes” and then 

double click “Axis 1”: 

 
 

8. Select the “Settings” tab and then click “Link to PLC…” 

 
 

  

HINT: Failure to do this will result in the PLCopen axis not appearing in the list when 
linking the PLC Axis to the Motion Axis. 
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9. When the “Select Axis PLC Reference (‘Axis 1’)” dialog appears, select “MAIN.Axis1” and 
then click “OK”.  

 
Now the axis is ready for normal PLCopen motion programming. 
 

10. The next steps are the same whatever the platform e.g. Power the axis using MC_Power, 
Read the status using MC_ReadStatus, and jog using MC_Jog. To add this functionality the 
control blocks must be declared e.g. 

 
 
Next, call the function blocks from the program area: 
 

 

 
 

HINT: As a minimum the Axis must be linked to each PLCopen FB instance i.e. “Axis := 
Axis1”. 



                           Page 61 of 153  

  

11. Press activate configuration to compile the software, and load it to the target, and set run 
mode:  

 
 
Click “OK” on the “Activate Configuration” dialog 

 
 
Click “OK” on the restart TwinCAT dialog. 

 
 
The PLC changes to run mode as shown by the box surrounding the green TwinCAT state 
symbol: 
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12. Click the login icon  to view the code while it runs: 
 
Click “OK” to the “TwinCAT PLC Control” dialog.  

 
 
The live values for each of the PLCopen function blocks may be seen: 
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13. Run the application (if it is not already running) by pressing the  button. 
 
When the system is running the online tool bar looks like this: 

 
 

14. To power the axis, apply 24V to the drives STO / Enable input. Expand Axis1Power and then 
then click in the prepare box to the right of the values of the Enable, Enable_Positive, and 

Enable_Negative inputs. Press the “Write Values” button  or Ctrl+F7 to set the prepared 
values.  

 
 
After the values have been applied the value changes as shown and the drive will be enabled 
and in “Run”:  
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15. The axis may be Jogged by setting the JogForward or JogBackwards bits. If the inputs for 
Velocity, Acceleration, and Deceleration are left at 0, the default values configured in “Axis 1” 
> “Parameter” tab. Click in the “Prepared Value”  box for JogForward to set it to TRUE and 

then press the “Write Values” button :   

 
 
The axis will begin jogging. To stop the axis repeat this procedure but instead click the 

prepared value until FALSE is shown and then click “Write Values”  or Ctrl+F7. 
 

16. When the complete motion system has been programmed, the position loop can be tuned 
using the worst case working motion profile e.g. one that has the highest acceleration rate 
and jerk. See section 10.10 How and when to tune the Position Loop. 
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10 How to guides 

10.1 How to home using MC_Home 

MC_Home is the standard homing function specified by the PLCopen standard. In TwinCAT like many 
other PLCopen IDEs, this triggers the homing functionality in DS402 to perform the homing function. 
The majority of the setup for this homing mechanism is actually defined by the “Axis 1” “Parameter” 
tab, and the “Enc” parameter tab.  

 

 

 

The default homing operation when using MC_Home is the classic homing profile shown below: 
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In the previous profile when homing is started: 

• The axis will search forwards for a homing switch that has been routed to the MC_Home 
blocks bCalibrationCam (Home Switch) input. 

• When the homing switch sets MC_Home. bCalibrationCam = TRUE, the motor will reverse 
direction looking for bCalibrationCam to change state to FALSE. 

• When MC_Home. bCalibrationCam = FALSE, the position is reset to MC_Home.Position. 

• The axis slows down and stops, and MC_Home.Done is set to TRUE. 

 

To test the behaviour, use the following steps: 

1. Set Configuration Mode by pressing  and then click OK to all the following dialogs. 
2. Declare an instance of MC_Home called Axis1Home and then reference it in the program 

area:  
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3. Press activate configuration to compile the software, and load it to the target, and set run 
mode:  

 
 
Click “OK” on the “Activate Configuration” dialog 

 
 
Click “OK” on the restart TwinCAT dialog. 

 
 
The PLC changes to run mode as shown by the box surrounding the green TwinCAT state 
symbol: 

 
 

4. Click the login icon  to view the code while it runs: 
 
Click “OK” to the “TwinCAT PLC Control” dialog.  
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5. Run the application (if it is not already running) by pressing the  button. 
 
When the system is running the online tool bar looks like this: 

 
 

6. To power the axis, apply 24V to the drives STO / Enable input. Expand Axis1Power and then 
then click in the prepare box to the right of the values of the Enable, Enable_Positive, and 

Enable_Negative inputs. Press the “Write Values” button  or Ctrl+F7 to set the prepared 
values.  

  
 

7. Expand the HomeAxis1 in the declaration area to reveal the MC_Home controls:  
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8. Start the homing process by setting Axis1Home.Execute = TRUE by clicking the prepared 

value box until it says true and then press the Write Value button : 

 
 

9. The axis runs forward. To simulate hitting the homing switch, set Axis1Home. 
bCalibrationCam to TRUE by clicking the prepared value box until it says TRUE and then 

press the Write Value button : 
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10. The Axis runs backwards looking for the falling edge of Axis1Home. bCalibrationCam. To 
simulate releasing the homing switch, set Axis1Home. bCalibrationCam to FALSE by clicking 

the prepared value box until it says FALSE and then press the Write Value button : 

 
 

11. The position is reset, the axis stops, and Axis1Home is set to TRUE indicating that the 
homing sequence has completed.  

 
 

For further information on MC_Home Setup see the Beckhoff Information System 
https://infosys.beckhoff.com/  
 
  

  

https://infosys.beckhoff.com/


                           Page 71 of 153  

  

10.2 How to configure PDO mappings 

This section covers a range of subjects relating to common automation tasks and configuring PDO 
mappings.  

10.2.1 How to map touch probe PDOs 

Using the default ESI PDO mappings, the Touch probe functionality is not mapped, and will result in 
MC_TouchProbe giving an error ID of 0x701 (1793). When Touch Probe 1 and 2 are mapped 
correctly it looks like this in the project tree: 

Grey box indicating 
that the PDO is 

linked to the NC Axis
 

To resolve this, the following steps show how to map the data in: 

1. Put TwinCAT in Config mode by clicking on the  button. 
 

2. Locate the drive to add the links to under “I/O” in the solution explorer. Double click on the 
Drive name e.g. Drive 1: 

 
 

3. When the properties browser opens, select the “Process Data” tab: 
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4. To set the PDO List find “Inputs - Position Control” box, and click on it to highlight the 
selection: 

 
5. Right click in the “PDO Content” box, and right click, then select “Add New Item…”: 

 
 

6. When the “Pdo Entry dialog” appears, scroll through the “From Dictionary:” options and look 
for 0x60B8 or Touch Probe Function. Click on this entry when it has been located. The details 
of the mapping will be automatically added. Click “OK” when finished. 
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7. This process is repeated for the outputs. Select the PDO list item marked Outputs – Position 
Status 

 
 
Then add a new item: 

 
 
Then Select 0x60B9 – Touch Probe Status, and click OK when completed: 
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8. If only 1 touch probe is required just map the edge type required using the previous method. 
By default positive edge is selected by the touch probe instance. 

 
 

9. It is possible to include all 4 edges if required for Touch probe 1 (negative and positive) and 
Touch probe 2 (negative and positive): 

 
 
For simplicity, this example continues assuming Touch probe 1 is used with a rising edge 
only. 
 

HINT: A minimum of firmware V01.61.00.00 drive firmware and EtherCAT firmware 
V01.12.00.24 with the associated ESI files are required to use this functionality. 
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10. When the PDO mappings are added they need a further step to link them to the axis. 

Grey box indicating 
that the PDO is 

linked to the NC Axis

The new PDOs don t 
have the grey box and 

are not linked yet 
   

 
11. To link the new Touch Probe PDOs, double click on the axis associated with the drive and 

select the settings tab. When the tab is open click on “Link to I/O…”: 

 
 

12. When the “Select I/O Box / Terminal” dialog appears, select (none) and then click “OK”: 

 
 

HINT: In the latest versions of TwinCAT the axis linking process happens automatically. 
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13. Click “Link to I/O…” on the Settings tab a second time, and when the “Select I/O Box / 
Terminal” dialog appears, choose the drive that is associated with the axis and click “OK”: 

 
 

14. The TwinCAT system will then automatically connect the Axis to the drive PDO mapping: 

Grey box indicating 
that the PDO is 

linked to the NC Axis

 

15. Save the changes by pressing  and activate the configuration by pressing . Touch 
probe can now be used without errors using MC_TouchProbe and TRIGGER_REF. 
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10.2.2 How to convert parameter numbers to CANopen object references 

Parameters are converted to CANopen style object reference using the following formula: 

 Index = 0x2000 + 0x100 * Slot Number + Menu number (converted to hexadecimal) 

 Subindex = Parameter number  

E.g. Drive parameter Pr3.017 is referenced as Index = 2003, Subindex = 17. 

 
 
 

 

10.2.2.1 Short drive parameter references 

Pr20.021   Index 0x2014 Sub-index 21 

Pr20.021 

Menu 
Number

Short drive parameter 
references (mm.ppp)

Equivalent CAN object 0x2014  
Fixed

Index 
(hex value)

Convert 
to hex

Parameter 
Number

21  
Sub-index 

(Decimal value)  

HINT: The slot number is 0 for standard drive parameters such as Pr3.017. 

. 
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10.2.2.2 Long option parameter references 

Pr3.02.025   Index 0x2302 Sub-index 25 

Pr3.02.025 

Menu 
Number

 Long option slot 
parameter references 

(s.mm.ppp)

Equivalent CAN object 0x2302  
Fixed

Index 
(hex value)

Parameter 
Number

25  
Sub-index 

(Decimal value)

Convert 
to hex

Slot 
Number
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10.2.2.3 How to find the parameter data type 

The data type can be found by looking at the parameter reference guide in Connect. Click “Parameter 
Reference Guide” in the Device tree and then expand “Parameter Reference”, then expand the drive 
mode e.g. Open-Loop, RFC-A or RFC-S, then select the menu number for the target parameter for 
the PDO e.g. Menu 20. 

 
 
If you are unsure of the mode that the drive is in double click on “Setup” >  “Drive Configuration” and 
the current mode will be shown when the drive is “Online”. 
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Select the parameter to get the data type for: 

  

 

The parameter reference guide gives a number of bits and a minimum and maximum which may be 
used to find the IEC data type e.g. DINT. The table below show how to convert to IEC data type used 
by TwinCAT: 

Bits from parameter 
reference guide 

Signed range IEC data type 

1 N/A BOOL 

8 No USINT 

8 Yes SINT 

16 No UINT 

16 Yes INT 

32 No  UDINT 

32 Yes DINT 

 
E.g. Pr20.021 is a 32bit value and the range is -2147483648 to  
2147483647 which shows that the value is signed, therefore the IEC data type used in TwinCAT is 
DINT. 

Bits from parameter 
reference guide Pr20.021 

Signed range IEC data type 

32 Yes DINT 
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10.2.3 How pass data between drive parameters and variables using PDOs  

This section shows how to map data from a PLC program variable to a drive parameter via PDO 
mapping, and from a drive parameter to a PLC program variable via PDO mapping. The following 
instructions show how to map to and from Menu 20 parameters in the drive, however the same 
philosophy can be applied to any parameter. 

1. For the purposes of this example the PDO mappings will interact with variables in a GVL 
(Global Variable List) making the data available to any POU. Right click on the GVL folder 
and select “Add” > “Global Variable List”. Name the list and then in declaration area of the 
GVL add the following:  

 

 
2. When the GVL is created build the application by pressing Ctrl+Shift+b. This will make the 

GVL elements available in later steps. Failure to do this will mean that the variables such as 
FromDriveToPLC will not appear in the data mapping selector. 
 

3. In the “Solution Explorer” tree, double click on the drive node to exchange PDO data with to 
open the drive properties. Next click on the “Process Data” tab, then select the 0x1A02 index 
from the PDO list, then right click in the PDO Content box and select “Add New Item…” 

   
 

  

HINT: The variables in the list have been allocated to the I and Q memory areas. This is a key 
step that allows the variables to be “seen” in the in the PDO linking list. Take care to use the 
correct memory area where I registers are for data going from the drive to the PLC, and Q 
registers are for data going from the PLC to the drive. 

HINT: The “*” used in the memory allocation e.g. %I* allows the TwinCAT system to select which 
area of the registers should be used. This is recommended. 
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4. How to convert parameter numbers to CANopen object referencesUsing the information in 
section 10.2.2 How to convert parameter numbers to CANopen object references, add 
the reference for the parameter to receive data from. For this example Pr20.030 will be used. 
Click “OK” when the parameter reference has been added. 

  
5. Select “0x1602” in the PDO list, then right click in the PDO Content box and select “Add New 

Item…”. Using the information in section 10.2.2 How to convert parameter numbers to 
CANopen object references, add the reference for the parameter to send data to. For this 
example Pr20.031 will be used. Click “OK” when the parameter reference has been added. 
add the reference for the parameter to send data to.  
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6. Map the Output PDO “M20.P30” to “GVL.FromDriveToPLC”. Expand the tree under the drive 
to reveal the Output mappings, then double click on the mapping to link. When the 
“Attach Variable” dialog opens, scroll down the list until “GVL.FromDriveToPLC” is seen. Click 
on “GVL.FromDriveToPLC” and then click “OK” to link the mapping to the variable. 

 

 
 
 

HINT: The link icon is now visible, (small grey box with an arrow inside), indicating that 
the PDO mapping has been linked.  
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7. Map the Input PDO “M20.P31” to “GVL.FromPLC_ToDrive”. Expand the tree under the drive 
to reveal the Input mappings, then double click on the mapping to link. When the attach 
variable dialog opens, scroll down the list until “ GVL.FromPLC_ToDrive” is seen. Click on “ 
GVL.FromPLC_ToDrive” and then click “OK” to link the mapping to the variable. 

 

 
 
 
 
 
 

HINT: The link icon is now visible, (small grey box with an arrow inside), indicating that 
the PDO mapping has been linked.  
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8. Click the “Activate Configuration” button and then click “OK” if the “Activate Configuration” 
dialog appears:  

 
 
 

9. Click the login icon  to view the code while it runs: 
 

10. Run the application (if it is not already running) by pressing the  button. 
 

11. Double click on the GVL in “Solution Explorer”. Values set in Pr20.030 in the drive are now 
passed to “GVL.FromDriveToPLC” and values set in “GVL.FromPLC_ToDrive” are passed to 
Pr20.031. 

 
In the previous example it can be seen that a value of “111” was passed from Pr20.030 to 
GVL.FromDriveToPLC, and that a value of “222” was passed from GVL.FromPLC_ToDrive to 
Pr20.031. The screen shot shows the GVL values from TwinCAT and the drive parameter 
values in Connect. 
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10.2.4 How to map a drive encoder to an NC encoder axis  

It is possible to map a drive encoder e.g. a line encoder connected to the drive P2 interface or an SI-
Universal Encoder module so that could be used as a master position reference for MC_GearIn or 
MC_CamIn. The following steps show how to configure the mapping and setup the Encoder axis. 

1. It is assumed that the encoder to map to has already been connected to a spare encoder port 
on the drive e.g. Drive P2 interface on the D-type encoder port, or an encoder module such 
as an SI-Universal Encoder fitted in one of the drive option slots. Find the Normalised 
Position parameter. The table below shows the parameters for each possible encoder port 
and the equivalent Index and Subindex to use in the TwinCAT Process Data mapping: 
 

Encoder port Parameter Index Subindex Data Type 

Drive P1 Pr3.058 0x2003 0x3A (58) DINT (32Bit) 

Drive P2 Pr3.158 0x2003 0x9E (158) DINT (32Bit) 

Slot 1 P1 Pr15.058 0x200F 0x3A (58) DINT (32Bit) 

Slot 1 P2 Pr26.058 0x201A 0x3A (58) DINT (32Bit) 

Slot 2 P1 Pr16.058 0x2010 0x3A (58) DINT (32Bit) 

Slot 2 P2 Pr27.058 0x201B 0x3A (58) DINT (32Bit) 

Slot 3 P1 Pr17.058 0x2011 0x3A (58) DINT (32Bit) 

Slot 3 P2 Pr28.058 0x201C 0x3A (58) DINT (32Bit) 

 

2. Ensure that the encoder is working by moving the encoder and at the same time check that 
the position in the relevant encoder interface parameter, as detailed in the previous table, is 
changing with the movement. 
 

3. In TwinCAT, double click on the EtherCAT slave drive to add the encoder PDO mapping to. 
When the properties for the slave drive open, select the “Process Data” tab, and then in the 
“PDO List” select object “0x1A02”. In the “PDO content” box scroll to the bottom of the list and 
then right click and then select “Add New Item…” 
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4. When the “Edit PDO Entry” dialog opens, enter the Name, Index, Subindex and Data Type as 
listed in the previous table. For this example, Slot 2 P1 is the location of the second encoder, 
and the mapping has been named “Line Encoder”. Click “OK” when finished. 

 
 

5. In the solution explorer under “Motion”, right click on “Axes” and select “Add New Item…”. 
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6. When the “Insert NC Axis” dialog opens, change the type to “Encoder Axis”. Click “OK” when 
finished. 

  
 

7. In the motion program POU add an instance of AXIS_REF for the Encoder Axis. 

 
 

8. In the Solution Explorer tree, double click on the encoder axis, (Axis 2), when the properties 
for the axis open, select the “Settings” tab. Click “Link To PLC”, and then select the new 
instance of AXIS_REF, e.g. “Axis2”.   
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9. Expand the encoder axis and double click on “Enc”, when the properties for the encoder open 
select the “NC-Encoder” tab. Change the “Type:” to “Encoder (universal)”  

  
 

10. Select the “Parameter” tab and then set the “Scaling Factor Numerator” to the number of units 
per revolution of the encoder, e.g.1000. Set the “Scaling Factor Denominator” to the number 
of encoder counts per revolution – by default this is 65536. 
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11. Expand the tree for the drive that the encoder is connected to, then open “Outputs”, and 
double click on the name given to the encoder PDO link created in step 4 e.g. “Line Encoder”. 

 
 
When the “Attach Variable Line Encoder (Input)” dialog opens scroll down to the axis 
associated with the encoder, e.g. Axis 2 and select “Axis 2” > “Enc” > “In” > “nDataIn1” and 
then click “OK”. 

 
The PDO for the encoder is now linked to the encoder axis as indicated by the small grey box 
with an arrow in it: 

 

12. Apply the new settings to the project by clicking the “Activate configuration button” . Click 
“OK” to any following message boxes. 
 
 

HINT: “nDataIn1” is always where the encoder data is mapped to, regardless of the axis 
number.  
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13. Verify the encoder is working by double clicking on the encoder axis e.g. Axis 2, and when the 
properties for the axis open, select the online tab to view the position. This will change as the 
encoder is moved.  

 
 

14. The encoder reference can now be used as the master for an MC_GearIn or MC_CamIn by 
using the axis name e.g. Axis2.  
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10.3 How to view CAN objects 

Connect has a powerful diagnostic aid to help the user view CANopen object live called the CAN 
Object Viewer. This helps the user to diagnose setup and operational issues with the CiA402 system 
layer upon which EtherCAT and NC axes run. If the TwinCAT network isn’t starting, or a drive axis 
isn’t running when it should, this tool can help the user understand what is going on. 

The tool is found in the Drive explorer tree under “Options” > “Slot[n]” > “CAN Object Viewer” where 
[n] is the drive slot in which the SI-EtherCAT interface is located.  

 
For Dedicated EtherCAT Drives Such as Digitax HD M753 it is found in the drive explorer tree under 
“EtherCAT” > “CAN Object Viewer”. 

 

The image below shows an example of the CAN Object Viewer during use: 
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The following image highlights some of the useful features and information available within this tool. 
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10.3.1 MC_Power Disabled and Drive Disabled 

This screenshot acts a guide to understand the expected CiA402 Status and Control word for a 
TwinCAT NC axis with a disabled drive (STO = 0V) and MC_Power.Enable = FALSE.    

  
 

10.3.2 MC_Power Disabled and Drive Enabled 

This screenshot acts a guide to understand the expected CiA402 Status and Control word for a 
TwinCAT NC axis with a disabled drive (STO = 24V) and MC_Power.Enable = FALSE.    

 
 

 

 

10.3.3 MC_Power Enabled and Drive Enabled 

This screenshot acts a guide to understand the expected CiA402 Status and Control word for a 
TwinCAT NC axis with a disabled drive (STO = 24V) and MC_Power.Enable = TRUE.   

  
 
 

 

 

HINT: “Ready to switch on (0)” is now active. 
 

HINT: “Switch on (0)”, “Enable operation (3)”, “Switched on (1)”, “Operation enabled (2)”, 
and “Active (12)” are now active. 
 



                           Page 94 of 153  

  

10.4 How to setup axis unit scaling and resolution 

Unit scaling in most motion control systems, including a TwinCAT NC axis, requires the user to 
specify the number of feedback counts there are for a given distance, where feedback in counts is 
converted into Application units such as degrees or mm. Normally this is represented as a numerator 
and denominator where: 

• The numerator is the number of distance units. 

• The denominator is the number of position feedback counts that equals the numerator value. 

There are number of different ways to set up the position feedback scaling but the easiest is based 
around rotating the motor by 1 revolution and indicating how many feedback counts (as seen by the 
drive) there will be per revolution and how many Application units will be moved in 1 revolution. 

By default, the number of feedback counts per revolution is set to 65536. If the applications units are 
degrees and there is no output gearbox, the unit scaling ratio would be set to a numerator of 360, and 
a denominator of 65536. In TwinCAT it looks like this: 

 

 

 

If we add a 4:1 reduction gearbox, the number of rotations at the output of the gearbox is reduced by 
the gearbox ratio so in this example the scaling numerator is 360 * 1 / 4 = 90. 

The encoder resolution used by TwinCAT NC axis is set by drives feedback resolution as defined by 
Pr3.057 Normalisation Turns, where the number of counts per revolution can be calculated by using 
the following formula: 

Encoder Counts Per Revolution = 2(32-NormalisationTurns Pr3.057) 

In the drive, the resolution in feedback counts is given by 2(32-Pr3.057).  

By default, Pr3.057 P1 Normalisation Turns = 16 so the number of feedback counts per revolution is 
2(32-16) = 65536.  

15 01631

P1 Normalised position Pr3.058 or 
Position Actual Value 0x6064

16bit Position per revolution16 bit Turns Pr3.057 = 16

32bit position value  

Provided the feedback encoder has a resolution greater than 16bit, the resolution of the axis can be 
increased by modifying P1 Normalisation Turns Pr3.057, where a reduction in the number of turns bits 
adds more feedback counts per revolution.  
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For example, if a 19bit per revolution encoder is used, the number of turns bits is reduced to 13 to 
give 19bits of turns information: 

15 01631

P1 Normalised position Pr3.058 or 
Position Actual Value 0x6064

19bit Position per revolution13 bit Turns Pr3.057 = 13

32bit position value  

The following table can be used to help with determining the correct turns bits value to use based on 
the encoders number of counts per revolution. 

Pr3.057 Turns bits Counts per revolution Bits per revolution Turns bits as hex 

16 65536 16 0x10 

15 131072 17 0x0F 

14 262144 18 0x0E 

13 524288 19 0x0D 

12 1048576 20 0x0C 

11 2097152 21 0x0B 

10 4194304 22 0x0A 

9 8388608 23 0x09 

8 16777216 24 0x08 

7 33554432 25 0x07 

6 67108864 26 0x06 

5 134217728 27 0x05 

4 268435456 28 0x04 

 

 

 

 

The two main ways to setup Pr3.057 are by configuring the value in Connect and saving it, or by 
setting Pr3.057 in the startup list in TwinCAT directly, or by exporting the startup list from Connect 
once the system / application is fully commissioned. 

  

HINT: The total resolution is always 32bit, where the sum of the turn’s bits and bits 

per revolution always adds up to 32bits. 
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10.4.1 How to set the resolution using the startup list in TwinCAT 

The resolution is configured by default in Pr3.057. See the previous table for the number that the 
turns bits should be set, (Hex value), to for a particular number of counts per revolution.   

For setup in the startup list the following data is needed: 
 

Parameter Index (hex) Subindex (dec) Comment 

Pr3.057 2003 57 Turns bits 

Use the following steps to configure a startup list entry for a drive parameter directly: 

1. Double click on the drive to modify the startup list for, from the properties select the “Startup” 
tab, and then click “new”. 
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2. When the “Edit CANopen Startup Entry” dialog opens, populate it as shown below and check 
the “Complete Access” checkbox to allow the Sub-Index to be configured: 
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3. Uncheck the “Complete Access” checkbox and then click “OK”. 

 
 

4. The new entry in the Startup list looks like this: 

 
 

5. Click the Activate Configuration button to apply the startup list.  
 

6. Click OK on the “Restart TwinCAT System in Run Mode” dialog. 

 
 

7. After a few seconds the system will reset, and the new setting will be applied in the drive. 
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10.4.2 How to scale between NC axis speed and rpm 

To convert an NC axis speed in units/s into rpm use the following formula: 

  Drive speed in rpm =  Speed(Units per s) * 60 / Scale Numerator 

E.g. The axis is running at 1000°/s  with a scaling numerator of 360 per rev. The resulting speed in 
rpm observed in Pr3.002 is 1000 * 60 / 360 = 166.6rpm 

 

To convert the speed seen at the drive, in rpm, into NC axis speed  in units/s use the following 
formula: 

  NC axis speed =  Speed(rpm) * Scale Numerator / 60 

E.g. The axis is running at 1000rpm  with a scaling numerator of 1234 mm per rev. The resulting 
speed in rpm observed in the NC axis ActVelo parameter is 1000 * 1234 / 60 = 20566.6rpm 
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10.5 How to upgrade EtherCAT Firmware 

There are 2 main ways to update the firmware and they are each used in different situations.  

The most common way as described in section 10.5.1 How to upgrade the EtherCAT interface 
firmware using Connect shows how to update the firmware using Connect which us used when there 
is an existing, working connection to the drive, either by ADS or AoE or serial / ethernet 
communications. 

The second method is for situations where communications is by EtherCAT and it hasn’t been 
possible to establish an ADS or AOE connection. In this scenario it is recommended to use FoE in 
TwinCAT to update the firmware. This is described in section 10.5.2 How to use FoE to update the 
EtherCAT interface firmware. 

10.5.1 How to upgrade the EtherCAT interface firmware using Connect 

When setting up an EtherCAT network it is important to make sure the ESI file and firmware match 
each other to prevent issues when starting the EtherCAT network. The following steps assume that 
there is a working EtherCAT connection already – if a connection can’t be established, use the steps 
in section 10.5.2 How to use FoE to update the EtherCAT interface firmware. 

1. Before updating using the EtherCAT interface using Connect, in the TwinCAT project, 

uncheck the “Check Product Code” and “Check Revision Number” check boxes in the 

EtherCAT drive properties, and then activate the configuration . This is so that the changes 

to the product code that will happen when the firmware is updated don’t cause ADS / AoE 

communications to stop part way through the firmware update.  

 
 

2. Install and open the “Connect” PC tool. 

 

3. Establish a connection between the PC being used for Connect and the Control Techniques 

drive, this connection can be achieved via Ethernet, EoE, ADS, or serial communications. 

 

HINT: Ethernet and Serial communications may be used directly with the drive, but any 
EtherCAT-based communications require an EtherCAT network Master to be configured 
before the drive can be communicated with such as a PLC or IPC. 
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See sections 3 and 4 for details on how to establish the connection over an EtherCAT 

network using a Beckhoff TwinCAT PLC / IPC, and AoE / ADS communications as described 

in section 4 Setup an EtherCAT AoE connection from the PLC to the drive, is the easiest 

to work with. The remaining firmware upgrade steps shown using ADS. 

4. Highlight the drive to upgrade in the project tree and then click “Online”.  

 

5. From the drive explorer tree double click on “Maintenance” and then “Change Firmware”: 
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6. The “Firmware Transfer” tool will open. This tool displays the current firmware present in the 
drive and any connected option modules. 

To perform a firmware upgrade, select the slot that the SI-EtherCAT module is installed in 
and click the “Browse…” button to locate the SI-EtherCAT firmware: 

  
Make sure that the drive is disabled and that any application software modules e.g. MCi210 
or SI-Applications Plus have their programs stopped.  

Click    to continue. 

7. Click “Start Download” to begin the transfer of the firmware. Please ensure that the drive 
remains powered up and the communications stay intact until the process has completed. 

 

8. Power down the PLC/IPC and drives, then re-apply power to re-establish the network. 

  

  

  

  

HINT: Downgrading the firmware using Connect over ADS may not fully work since the 
ESI file used in the PLC / IPC will no longer match the target after the firmware has been 
transferred to the EtherCAT module and the EtherCAT master will stop ADS 
communications. For this type of transfer it is recommended to use Ethernet or serial 
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10.5.2 How to use FoE to update the EtherCAT interface firmware 

In situations where it hasn’t been possible to establish communications to the drive and only 
EtherCAT communications are available, instead of using Connect over ADS / AoE, it is possible to 
load the firmware directly using TwinCAT provided the EtherCAT interface firmware is greater than 
V01.08.00.14.  

For firmware older than V01.08.00.14 an alternative connection must be made to the drive using 
Control Techniques RS485 adapter, or using Ethernet and an SI-Ethernet / Factory Fitted Ethernet 
option, or a KI-Keypad Plus.  

This situation might occur if the EDS files installed in TwinCAT don’t match the firmware in the 
module. Before using this method, make sure that the EDS files in TwinCAT match the firmware that 
will be loaded in the following steps. 

It is assumed that the steps in section 3 Initial TwinCAT project setup have been followed to create 
a project before using these steps.  

For a brand new project it is strongly recommended to update to EtherCAT interface V2 firmware 
and ESI files. Use the following steps to update the firmware: 

1. Expand “I/O” in the Solution Explorer and then right click on “Devices” and then select “Scan”: 
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2. Click “OK” to the “HINT: Not all types of devices can be found automatically” pop-up. 

 
 

3. After the device search finishes, select the EtherCAT interface and then select “OK”. 

 
 

4. Select “Yes” when the “Scan for boxes?” pop-up appears: 

 
 

5. Click “OK” to adding “NC – configuration”. 
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6. Click “Yes” on the “Activate Free Run” pop-up.  

 
 

7. Double click the EtherCAT master to open its properties and then select the “Online” tab: 
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8. Right click on the drive to update and then select “Firmware Update…” 

 
 

9. The file explorer opens. Set the file type to “All Files (*.*)”, then select the firmware file, and 
then select “Open”. 
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10. When the “Edit FoE Name” pop-up appears change “String:” to the correct file path for the 
firmware image file which is “/fw/app”, and then select “OK”.

 
 

11. The file download runs. Wait until it finishes. 

 
 

12. When the download completes the “Function Succeeded!” message appears. Click “OK”. 
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13. Delete the drive that has been updated in the Solution Explorer tree. 

  
Click “OK” to the following message: 

 
 

14. Right click on the EtherCAT master in the solution explorer tree and then select “Scan”. 
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15. When the “EtherCAT drive(s) added” dialog appears select “Cancel” so that another NC axis 
isn’t added to the project. 

 
 

16. Link the NC that was created for the drive axis originally, back to the drive EtherCAT comms 
by double clicking on the axis e.g. Axis 1 to open it properties and select the “Settings” tab. 
Click on “Link To I/O…”, select the Drive from the list to link to the axis, e.g. Drive 1, and then 
select “OK”. 
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17. Click the “Activate Configuration” button and then click “OK” if the “Activate Configuration” 
dialog appears:  

  
 
Click “OK” on the “Restart TwinCAT in Run Mode” dialog:  

 
 

18. If the system is operating properly the status Icon in the bottom right corner of TwinCAT will 
show a green box with a rotating cog: 

 
 

19. Communications will now be running and Connect will be able to search for the drive(s) on 
the EtherCAT network using the “NetId:”. If the In Connect Scan the network to find the drive. 
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20. If the EtherCAT firmware has been upgraded from V1 to V2 a save is required to 
acknowledge the update. Start a project as described in section 5 Configure the drive using 
Connect and once the project is open, select the drive to save and then click “Save 
parameters in drive” to complete the process. 
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10.6 How to setup a Beckhoff IPC 

IPCs from Beckhoff such as the C6025 are not supplied with the TwinCAT runtime or any EtherCAT 
port setup. The following steps can be used to turn a Beckhoff IPC into a TwinCAT controller. 

1. Apply 24V to the IPC. Follow the user guide for the IPC for the details on the power connector 
wiring. 

2. Plug a monitor, keyboard and mouse into the IPC. 
3. After a short wait the Beckhoff Device manager will be shown: 

 
4. Select Connectivity and then click the spanner icon on the top right of the Device Manager to 

configure a static IP address: 
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5. Choose an ethernet port that will become the Ethernet connection to your PC. There is 
normally 1 port that is slower than the others, this is the best port to use for the PC connection 
since the high-speed ports should be used for EtherCAT real time communication. 

 
 

6. Click the tick  to apply the settings and then reboot. 
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7. Using the command prompt or Powershell, ping the new IP address to make sure it is 
operational. When the command prompt is shown type “ping ” followed by the IP address 
assigned e.g. “ping 192.168.1.199”. The screen shot below shows a successful ping: 
 

 
 

8. From this point onwards, the Beckhoff Device Manager can be accessed using a web 
browser e.g. type in “https://192.168.1.199/config/”. 
  

9. Get the TwinCAT XAR runtime form the Beckhoff website and put it onto a USB stick: 

 
Put the USB stick with the runtime on it into one of the IPCs USB ports. 
 

10. Using file explorer on the IPC locate the USB stick, copy the files from the USB to the IPCs 
documents folder, and then double click on the installer file to start the installation. When the 
installation completes the IPC must be rebooted. 
 

11. When the IPC boots up the “TC” LED will now be lit up blue. 
 



                           Page 115 of 153  

  

12. Access the IPC file system using File Explorer and navigate to C:/TwinCAT/3.1/System. In 
this folder there is a file called “TcRteInstall.exe”. Double click on this to assign the EtherCAT 
network port on the IPC. 

 
 

13.  When the installer opens, click on the port to become the EtherCAT network port in the 
“Compatible Devices” list and then click “Install”. When the process is completed the newly 
installed port will appear in the “Installed and ready to use devices (realtime capable)” list. 

 
 
Close the installer when finished 
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14. In the same folder location, C:/TwinCAT/3.1/System, run win8settick.bat as an Administrator, 
(right click on the file select “Run as Administrator…”).  
 

 
 

15. When the batch file completes, reboot the IPC. 

 
16. The IPC can now be used with TwinCAT. 
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10.7 How to Remove “???” from LD diagram POU inputs and outputs 

LD diagram language can be a nice way to explore the functionality of the NC axis PLCopen function 
blocks. Each input and output can be seen side by side, any enumerated values selected, and all 
output values may be seen.  
 
However, the default environment behaviour when using the LD language can be cumbersome when 
inserting function blocks to a ladder rung. All of the POU Inputs and Outputs have “???” next to them 
which must be deleted or overwritten before the program can be compiled which is time consuming.  

 

The “???” at the POU’s I/O is optional. The following steps show how to turn this off:  

• Go to “Tools” >” Options” 

• Go to “TwinCAT” > “PLC Environment” > “FB LD and IL editor”. 

• Check the “Empty operands for function block pins” 
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After making this change, when new POUs are inserted to a rung, only the first output has “???” 
which is much easier to delete: 
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10.8 How to use a startup list in TwinCAT 

The startup list for an EtherCAT device is a helpful way to configure CiA402 CAN objects and drive 
parameters (addressed as CAN objects) when an EtherCAT node starts. There are a couple of 
standard ways in which this feature is used: 

1. To apply the parameters used to setup a drive axis from scratch. This will restore the original 
drive configuration in case the drive parameters have been altered. It can also be used to 
automatically configure a brand new drive (assuming the drive and EtherCAT option firmware 
match) in the event that a drive is replaced. 

2. To configure CiA402 CAN objects that define how the system operates such as the behaviour 
of the drive when comms are lost via object 0x3005. 

The following sections detail how to use TwinCAT in these scenarios. 

 

  



                           Page 120 of 153  

  

10.8.1 How to import a startup list .xml file from Connect into TwinCAT 

A startup list .xml file can be generated by Control Techniques Connect after the axis has been 
commissioned. A startup list generated by Control Techniques Connect software holds all of the 
changes made to the drive in a format that TwinCAT can import, so that every time the drive is 
powered up, its settings are restored. This can be helpful if a drive has to be replaced, since the 
previous setup is restored including things like motor map, encoder type, tuning values etc. 

This startup list should be generated after the speed and position loops have been tuned so that all of 
the setup is retained. 

The following steps show how to import the file into TwinCAT: 

1. An EtherCAT startup list may be generated to preserve the configuration in the TwinCAT 
PLC/IPC. The startup list is in the form of an startup list .xml file that may be imported into 
TwinCAT. The export start-up list button can be found on the “Finalize” step in the guided 
setup.  

 

 
 
StartupList.xml is stored in the following location: 
C:\Users\[USER NAME]\Documents\Control Techniques\Connect Cobalt\[PROJECT 
NAME]\devices\[DEVICE NAME]\StartupLists. 
 
Open the TwinCAT project. 
 

2. Make sure config mode is selected as indicated by the blue config button being highlighted. 
Click the blue Config button if it is not highlighted. 
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3. Double click on the drive node in the Solution explorer pane, that the startup list .xml file will 
be applied to. This opens the properties for the drive node. 

 
 

4. Select the Startup tab. Right click anywhere on the startup tab, and select “Import XML 
Description…” 
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5. Navigate to the location of the startup list generated by Connect. The general form for the 
path to the .xml file is “C:\Users\[USER NAME]\OneDrive\Documents\Control 
Techniques\Connect Cobalt\[PROJECT NAME]\devices\[DEVICE NAME]\StartupLists” 
 
Alternatively the path for the .xml file can be copied by opening the original Connect project, 
go to “Setup” > “Finalise” page and then click on “Export Startup List” and then copy the path 
from the explorer window. 

 
 
Paste the path from Connect into the TwinCAT import .XML window path and click “Open” 
when finished. 
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6. A pop up will ask if the original start up list should be deleted? Select “No” which instead of 
deleting the original start up list and replacing it with the one from Connect, it will append / 
add to the existing list with the extra setup imported from Connect. 

 
 

7. Apply the startup list by clicking the “Activate Configuration” button, and click “OK” or “Yes” 
on any following pop-up messages: 
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10.8.2 How to add a single CAN object to the TwinCAT Startup List & Cyclic 
comms loss action 

This section describes how to add single CAN objects to the startup list. The object may be ones 
specified by the CiA402 standard, custom ones as specified in the SI-EtherCAT manual e.g. 0x3005 
Cyclic data loss behaviour, or drive parameters arranged in CAN object format - see section 10.2.2 
How to convert parameter numbers to CANopen object references. 

Use the following steps to add ESI specified CANopen objects to the startup list in TwinCAT: 

1. Open the TwinCAT project. 
 

2. Make sure config mode is selected as indicated by the blue config button being highlighted. 
Click the blue Config button if it is not highlighted. Click “OK” on any following po-up 
messages.  

 
 

3. Double click on the drive node in the Solution explorer pane, that the startup list .xml file will 
be applied to. This opens the properties for the drive node. 

 
4. Select the Startup tab. Then click on “New”: 
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5. Select the CANopen object index and subindex to edit from the list. In this example Index 
3005 subindex 2 is selected. 

 
 



                           Page 126 of 153  

  

6. Double click on the subindex to open the “Set Value Dialog”. Enter the value as either a 
decimal or hex value. When finished click “OK” in the “Set Value Dialog” and the “Edit 
CANopen Startup Entry” dialog.  

 
 
 
 
 
 
 
 
 
 

7. The new entry is added to the startup list. 

 
8. Apply the startup list by clicking the “Activate Configuration” button. Click “OK” on any 

following pop-up messages. 

 
 

HINT: Data is entered in this tool in hex with the byte pair values entered in reverse 
endian format. This means the least significant byte pair is entered first followed by 
the other byte pairs with increasing significance. E.g. a 32bit value in conventional 
hex format is written as 0x 12 34 56 78, but in reverse endian format it is entered as 
0x 78 56 34 12. 
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10.9 How to setup an EtherCAT EoE connection 

This section details how to establish an EoE (Ethernet Over EtherCAT) connection after the controller 
and axis has been added to the project as shown by section 3 Initial TwinCAT project setup. 

1. Double click on the EtherCAT Device under “I/O” > ”Devices”, then select the EtherCAT tab, 
and then “Advanced Settings…”  

 
 

 

 
 
 
 

HINT: For IPCs and PLCs, the “Windows IP Routing” checkbox must be checked to 
allow the IPC to act as a router for the EoE messages. 
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In the registry for the IPC this sets IPEnableRouter to 0x00000001(1) 

 
 
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters 
 

2. Next, click on the drive to connect to, “I/O” > “Devices” > “Device (n)” > “Drive(n)”:  

 
 
When the device information opens, select the “EtherCAT” tab and then “Advanced 
Settings…” 
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3. When the “Advanced Settings” tab opens select “Mailbox” > “EoE”:  

 
 
Check the “Virtual Ethernet Port” box, then set the “IP Port” and “IP Address” radio buttons. 
The “IP Address” is set to the IP address that you would like the drive to have, which must not 
clash with the PLC’s EtherCAT port IP address, e.g. 192.168.2.20. The subnet mask is set to 
255.255.255.0. the Default gateway is set to the IP Address of the port that connects the drive 
to the PLC e.g. 192.168.2.10. Click “OK” when completed. 

4. Download the configuration to the PLC by clicking on Activate Configuration .  
 

5. Click OK on the “Restart TwinCAT System in Run Mode” dialog. 
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6. Create a persistent route in the PC to allow access to the EtherCAT Slave drive. Open the 
command prompt as an administrator by typing in “powershell” in the windows search, then 
right click on “Windows PowerShell” in the results and select “Run as administrator”.  

 
7. Add the persistent route using the “route” command: 

 
 
In this example: 
 

a. “route -p add” gives a permanent route that will persist even when the power is cycled 
on the PC. 

b. “192.168.2.0” allows routing to any IP address in the range of  192.168.2.1 to 
192.168.2.255. This is the PLC EtherCAT port address range. 

c. Subnet mask is “255.255.255.0” 
d. The gateway is set to the IP address of the Ethernet port on the PLC, used to connect 

to the PC, in this example the IP address of the PLC's Ethernet port is 192.168.1.10. 
e. The complete route add command is shown below so it may be copied and pasted:  

 
route -p add 192.168.2.0 mask 255.255.255.0 192.168.1.10  
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8. Use Route print to check the route is now listed: 

 
 

 
 

9. Test the route to the drive using ping, e.g. ping 192.168.2.20: 

 
 

10. PC tools such as Connect may now be used with the drive using the EoE IP Address e.g. 
192.168.2.20. 
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10.10 How and when to tune the Position Loop 

The axis position loop in the drive is activated once the NC axis is powered on, where: 

• The drive is enabled by applying 24V to the STO terminal. 

• The drive is healthy i.e. no trips. 

• MC_Power has been used, successfully, to power on the axis. 

• If a keypad is fitted, the display indicates “Run”. 

• If Connect is online, the status in the bottom left shows “Run”. 

  

The position loop should be tuned when the application software is written, and the machine is 
running with the worst-case production motion profile, i.e. the most dynamic motion profile coupled 
with the highest load that will be experienced by the system while running. 

In many cases the default position loop p gain of 25.00 will give reasonable performance, but in cases 
where there are tight tolerances, the position loop performance can be increased to suit the 
requirement. 

Before attempting to tune the position loop the speed loop must be tuned first as described in section 
6 Commission the drive and motor using Connect. 

With the machine running its worst-case motion profile, open Connect and go to the Performance 
Tuning step 

 
 

Don’t enable the test move control. The test moves status must say “No Control” to leave the 
application software in control of the drive and therefore the drive position loop active, ready for 
tuning. 
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Move the position loop p gain slider to optimise the tuning and observe the red AMC Position Loop 
Error trace. Move the slider to the right to increase the position loop gain and increase the response. 
The smaller the peak values the better the tuning is. 

 

If the P Gain needs to be pushed above 100 the range can be increased using the following control: 

 

Care must be taken when increasing the gain as it is possible to increase the gain until the system 
stability limit is reached and the axis motor will make additional noise or worst case oscillate. Small 
steps are recommended when tuning. 

If the tuning has reached the best possible position error and axis noise compromise, it is possible to 
reduce the error further by adding Jerk to the motion profile if one has not already been used. Even 
very high Jerk values can make a big difference to the peak position following error values when 
beginning and ending acceleration or deceleration. 

When the optimal value has been reached save the parameters in the drive. 
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10.11 How and when to use inertia compensation 

Inertia compensation, as the name suggests should only be used when there is significant load inertia 
and / or large acceleration rates. If the inertia is low or the acceleration rates are also low then this 
feature will not benefit the performance of the axis and is best not used. 

Inertia compensation engages a Torque Feedforward term in the drive which, assuming the motor 
and load inertia has been measured correctly, applies a torque reference to the drive in proportion to 
the motion profile acceleration output and the inertia value. This helps reduce speed loop following 
error during acceleration and deceleration, at the cost of slightly increased motor noise. 

Before using this feature the speed and position loops must be tuned first as described in sections 6 
Commission the drive and motor using Connect and 10.10 How and when to tune the Position 
Loop. 

To use the inertia compensation check the Enable inertia compensation checkbox on the 
Performance Tuning step of the guided setup. 
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If motor noise induced by the inertia compensation term must be reduced, or the amount of inertia 
compensation must be increased to further improve the following error, select manual speed loop 
tuning to disconnect the inertia value from the speed loop gain setting. Then decrease the inertia 
value to reduce motor noise or increase the inertia to increase the output of the inertia compensation. 

Before modifying the “Motor Inertia” make a note of the original value so it can be restored later if 
required. 

 
 

 

 

 

 

 

  

HINT: If the Inertia has been modified to tune the output of the Inertia Compensation 
feature, and Bandwidth mode tuning is later required, the inertia must be restored to its 
original value before selecting bandwidth mode, otherwise the speed loop gains may be 
calculated incorrectly. 
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10.12 How to set up a dual loop system 

This section describes how to configure a dual loop system where the position loop is closed using an 
encoder attached directly to the load side of the gearbox as opposed to the motor side. 

 

Gearbox

5:1

Speed 
Loop 

Encoder
Position 

Loop 
Encoder

Load side 
of gearbox

Motor side 
of gearbox

 

This type of system compensates for any backlash or torsional effects in the gearbox, resulting in a 
greater level of positioning accuracy at the load. 

For this example, it is assumed that the motor encoder is connected the drives P1 interface, whilst the 
position feedback encoder will be connected to the drives P2 interface. Therefore, we need to 
configure the following CANopen over EtherCAT (CoE) objects: 

• Index: 0x3000, Sub Index: 0 – Position Feedback Encoder Configuration. 

• Index: 0x3004, Sub Index: 1 – Additional Position Loop Output Scaling Numerator. 

• Index: 0x3004, Sub Index: 2 – Additional Position Loop Output Scaling Denominator. 

 

The following steps will describe how to cause the configuration of these CoE objects to happen when 
the PLC / IPC / Controller is first powered on using the startup list. 

 

1. Follow the relevant steps outlined in section 7 TwinCAT Axis Configuration to configure a 
TwinCAT project, an EtherCAT network configured with a single Control Techniques drive. 

2. Ensure config mode is selected as indicated by the blue config button being highlighted. 
Click the blue Config button if it is not highlighted. 
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3. From the project tree, double click on “Drive1” and select the “Startup” tab followed by the 
“New…” button: 

  

4. The “Edit CANopen Startup Entry” dialog will be displayed. 

From the list of available mappings, select “3000 Position Feedback Encoder Configuration”, 
enter “02” into the Data field and click “OK”. 

 
 
 

HINT: The value of 2 corresponds to the drives P2 Interface which is being used as the 

position interface in this example. Other interfaces can be selected using the values in 

the list below. 
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This list is an extract from Section 6.3.5 Feedback encoder source taken from the SI-
EtherCAT User Guide. 

  

5. The new entry will now appear in the “Startup Parameters” list. 
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6. From the “Startup” view, select the “New…” button. 
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7. The “Edit CANopen Startup Entry” dialog will be displayed. 

From the list of available mappings, select “3004 Scaling Numerator”. 

The value of the numerator is the number motor revolutions at the gearbox input required to 
achieve the distance of the denominator which is the number of gearbox output revolutions.  

For example, if a motor is coupled to a 5:1 step-down gearbox and no other gearing is used in 
the system, the value of 5 should be entered into the numerator “Value” field. 

Enter the numerator into the value field and click “OK”. 

 

 
 

HINT: The values specified in the “Data (hexbin)” are in the hex format, e.g. hex 14 = 

decimal 20 etc.  

“Data” is entered in reverse endian format  where the least significant bytes are entered 

first followed by next most significant and so on. This is a quirk of the TwinCAT Start up 

list editor. 

E.g. conventional format hex value is 0x 12 34 56 78, however in reverse endian format it 

is entered as 0x 78 56 34 12. 
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8. From the “Startup” object view, select the “New…” button. 

 

 

9. The “Edit CANopen Startup Entry” dialog will be displayed. 

From the list of available mappings, select “3004 Scaling Denominator”. 

The value of the denominator is the number of revolutions at the gearbox output required to 
achieve the distance of the numerator which is the number of gearbox input revolutions.  

For example, if a motor is coupled to a 5:1 step-down gearbox and no other gearing is used in 
the system, the value of 1 should be entered into the denominator “Value” field. 

Enter the numerator into the value field and click “OK”. 
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10. The Scaling Numerator, Scaling Denominator and Position Feedback Encoder Configuration 
mappings will now be present in the “Startup” list which means their values will be written to 
the specified CoE objects on startup of the PLC / IPC / Controller. A drive configured in this 
way will use the P2 interface for position control for any NC axis associated with this drive. 
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11. Make sure that the axis limits take the gearbox ratio into account.  
 
For example, if the gearbox ratio is 5:1 stepdown and the motor rated speed is 3000rpm, the 
maximum speed at the position loop encoder is 3000rpm * 1 / 5 = 600rpm.  

Gearbox

5:1

Speed 

Loop 

Encoder
Position 

Loop 

Encoder

600rpm 

maximum

3000rpm 

maximum
 

If the scaling of the position loop encoder is 1000units per revolution, the maximum velocity 
is 600rpm*1000units per revolution/60 seconds per minute = 10000units/s. 

 
 

12. Test to see if the scaling is correct by running at constant speed and make sure that that the 
positional following error seen in Pr39.008 using Connect doesn’t have a significant offset in 
it, i.e. the positional error should average out at close to 0. 
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10.13 How to apply velocity feedforward to an NC axis 

This section relates  to velocity feedforward with a NC axis being controlled using EtherCAT and 
DS402 in CSP (Cyclic Synchronous Position) mode, where the velocity calculated by the NC axis 
motion profiler is fed forwards directly to the target axis which improves the granularity of the velocity 
profiling, giving the smoothest operation. The velocity feedforward must be PDO mapped to 0x60B1 
and enabled by setting 0x300B = 1. The velocity feedforward is calculated from 
Axis.NcToPlc.SetVelo. This gives 100x better velocity reference resolution.  

The velocity feedforward functionality is only available with >=V02.00.00.16 EtherCAT firmware and 
ESI files. 

Position 
control

Velocity 
control

Torque 
control

M

S

+
+

+
+

Torque offset (60B2h)

Velocity offset (60B1h)

Target Position (60B0h)

Velocity actual value (606Ch)

Torque actual value (6077h)

Position actual value (6064h)

(Control when 0x300B = 1) 

 

For a normal axis using the default setup i.e. no velocity feedforward implemented, the drive 
calculates the velocity feedforward term by differentiating the position reference passed into 0x60B0. 
This tends to be noisier since the velocity granularity is based on whole position units. 

Position 
control

Velocity 
control
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control
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Velocity actual value (606Ch)
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                           Page 145 of 153  

  

Use the following steps to configure the velocity feedforward: 

1. Make sure that the firmware in the EtherCAT interface e.g. SI-EtherCAT is at least 
V02.00.00.16. This is the version that supports the feedforward mechanism. In Connect select 
“Maintenance” >  “Change Firmware”. All firmware versions for the drive and options will be 
listed. 

 
 

2. Put TwinCAT in Config mode by clicking on the  button. 
 

3. Enable the velocity feedforward term by setting 0x300B =1 in the startup list. Double click on 
the EtherCAT slave in the “Solution Explorer” tree. Select the “Startup” tab. From the list 
select the entry that starts with “300B”. When the PDO link boxes update, set “Data” to “01”. 
Click “OK” when finished. 
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4. For a normal NC Axis i.e. not a CNC axis, the user must calculate the velocity feedforward 
reference manually. To do this, open the axis in the solution explorer and check the encoder 
scaling: 

  
For the purposes of this description A numerator of 1000 units per revolution, and a scaling 
denominator of 65536 encoder counts per revolution is used. 
 
Add the highlighted code in the following code snippet to the PLC programming area e.g. 
“Main”. This reads the velocity from the axis and then converts it to into a velocity feedforward 
reference in Encoder Counts per Second suitable for use with the Velocity Offset 0x60B1. 
“VelocityFeedForward” is mapped to PLC Q registers using “AT %Q*” so that the PDO can be 
linked with the feedforward value. 

 
 
Build the code (Ctrl+Shit+B) after making this change so that “VelocityFeedForward” is 
selectable in the PDO linking editor.  
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5. Add a PDO mapping to 0x60B1. Double click on the EtherCAT slave drive, then select the 
“Process Data” tab. In the “PDO List” select the row that starts “0x1602”. In the “PDO 
Content” window select an empty row and the right click and select “Add New Item…”  

 
 
When the “Edit PDO Entry” dialog starts, select “0x60B1 – Velocity Offset” from the dictionary 
and then click “OK”. 

 
The PDO is now mapped. 
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6. Link the PDO mapping to the calculated velocity feedforward value. Expand the EtherCAT 
slave drive, then expand “Outputs – Position control”. Double click on “Velocity Offset” to 
open the “Attach Variable Velocity offset (Output)” dialog. Select “VelocityFeedForward” from 
the list and click “OK”. 

  
 
 

7. The setup is complete. Save the changes by pressing  and activate the configuration by 

pressing . Click the login icon  to load / view the code while it runs. Run the 

application (if it is not already running) by pressing the  button. 
 
When the system is running the online tool bar looks like this: 
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11 Additional information 

11.1 Mechanical brake controller logic 

11.1.1 RFC-S closed-loop permanent-magnet motor brake controller 

This section indicates the logic and timing diagrams for the brake controller in RFC-S mode for 
closed-loop permanent-magnet motors to help illustrate the functionality and timing. 
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11.1.2 RFC-A closed-loop induction motor brake controller 

This section indicates the logic and timing diagrams for the brake controller in RFC-A mode for 
closed-loop induction motors to help illustrate the functionality and timing. 
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